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1  Introduction
This user guide explains the capability, operation, and maintenance of the LevelVent 5, AquaVent 5, 
and the previous LevelVent and AquaVent water level and temperature dataloggers. Focus is on use with  
Solinst Levelogger Software (Solinst Protocol), with separate AquaVent User Guides discussing use with  
SDI-12 and MODBUS protocols. 

To begin using your datalogger, install Levelogger Software Version 4.6 (or higher).  
Please visit: www.solinst.com/downloads/ to download the current version or check for updates. 

1.1  Vented Water Level Dataloggers

The LevelVent and AquaVent are accurate water level and temperature dataloggers. They use a gauged 
(vented) pressure transducer. The pressure sensor is open to the atmosphere via a vented cable to surface, 
therefore, provides water level measurements that are automatically compensated for barometric effects, as 
well as temperature.

The loggers contain a desiccant and hydrophobic filter where the Vented Cable connects. There is no need to 
replace the desiccant or filter, they are designed to provide protection from moisture over the lifetime of the 
instrument, while still allowing air to vent to the transducer. 

LevelVent 5 and AquaVent 5 loggers have a baked-on coating using polymerization technology for extra 
corrosion resistance in harsh environments. They use the same Wellheads, Communication Cables, and 
Vented Cables as the previous LevelVent and AquaVent loggers.
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LevelVent 5 Models Full Scale Accuracy Resolution
M5 5 m (16.4 ft.) ± 0.3 cm (0.010 ft.) 0.001% FS

M10 10 m (32.8 ft.) ±  0.5 cm (0.016 ft) 0.0006% FS

M20 20 m (65.6 ft.) ± 1 cm (0.032 ft.) 0.0006% FS

Table 1–1: LevelVent 5 Logger Technical Specifications

Level Sensor: Piezoresistive Silicon with Hastelloy Sensor

Ranges: 5, 10, 20 m

Accuracy ± 0.05% FS

Normalization: Automatic Temperature Compensation 

Temp. Comp. Range: 0ºC to 50ºC

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Temp. Sensor Accuracy: ± 0.05ºC

Temp. Sensor Resolution: 0.003ºC

General:

Battery Life Estimate: 10 Years based on 1 reading/minute (in logger, not user replaceable)

Clock Accuracy (typical): ± 1 minute/year (-20ºC to 80ºC) 

Operating Temperature: -20ºC to 80ºC

Maximum # Readings: 150,000 sets of readings

Memory: Continuous or Slate mode

Communication Speed: 9600 bps Solinst USB

Size: 22 mm x 173 mm (7/8" x 6.8")

Weight: 190 grams (6.7 oz.)

Wetted Materials: Delrin®, Viton®, 316L Stainless Steel, Hastelloy, PFAS-free PTFE 

Corrosion Resistance: 
Baked-on coating using polymerization technology  
(inside and out) and Hastelloy pressure sensor

Sampling Modes 
(using Levelogger Software):

Linear, Event & User-Selectable Schedule with Repeat Mode,  
Future Start, Future Stop, Real Time View

Measurement Rates: 0.125 second to 99 hours

Barometric Compensation: Automatic

Figure 1-1 LevelVent 5 Logger

1.1.1  LevelVent 5

Note: To use the LevelVent 5 with Version 4.6 Levelogger Software, the LevelVent 5 logger must be using Firmware Version 1.004 
or higher. 

Note: The Model number refers to the depth of submergence below water level that the pressure sensor can withstand.  
i.e.: The LevelVent 5 which is available in M5, M10, and M20 ranges has actual water level ranges of 5 m(16.40 ft), 10 m 

More Info | Instructions | Get Quote 
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Table 1–2: AquaVent 5 Logger Technical Specifications

Level Sensor: Piezoresistive Silicon with Hastelloy Sensor

Ranges: 5, 10, 20 m 

Accuracy ± 0.05% FS

Normalization: Automatic Temperature Compensation 

Temp. Comp. Range: 0ºC to 50ºC

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Temp. Sensor Accuracy: ± 0.05ºC

Temp. Sensor Resolution: 0.003ºC

General:

Battery Life Estimate: 8 Years - based on 1 reading/minute (user replaceable in Wellhead)

Clock Accuracy (typical): ± 1 minute/year (-20ºC to 80ºC) 

Operating Temperature: -20ºC to 80ºC

Maximum # Readings: 150,000 sets of readings

Memory: Continuous or Slate mode

Communication Speed: 57,600 bps Solinst USB, 1200 baud SDI-12, MODBUS RS-232/RS-485 
(various speeds)

Size: 22 mm x 173 mm (7/8” x 6.8”)

Weight: 190 grams (6.7 oz.)

Wetted Materials: Delrin, Viton, 316L Stainless Steel, Hastelloy, PFAS-free PTFE

Corrosion Resistance: 
Baked-on coating using polymerization technology 
(inside and out) and Hastelloy pressure sensor

Sampling Modes 
(using Levelogger Software):

Linear, Event & User-Selectable Schedule with Repeat Mode,  
Future Start, Future Stop, Real Time View

Measurement Rates: 0.125 second to 99 hours

Barometric Compensation: Automatic

1.1.2  AquaVent 5

Note: To use the AquaVent 5 with Version 4..6 Levelogger Software, the AquaVent 5 logger must be using Firmware Version 1.004 
or higher. The Wellhead must use Firmware Version 1.001 or higher.

AquaVent 5 Models Full Scale Accuracy Resolution
M5 5 m (16.4 ft.) ± 0.3 cm (0.010 ft.) 0.001% FS

M10 10 m (32.8 ft.) ±  0.5 cm (0.016 ft) 0.0006% FS

M20 20 m (65.6 ft.) ± 1 cm (0.032 ft.) 0.0006% FS

Figure 1-2 AquaVent 5 Logger

More Info | Instructions | Get Quote 

https://www.solinst.com/products/dataloggers-and-telemetry/3500-aquavent/aquavent.php?utm_source=solinst-&utm_medium=INS-&utm_campaign=3500-WC-&utm_term=DT-global-&utm_content=INS-3250-3500-UG-3500moreinfo
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https://www.solinst.com/products/dataloggers-and-telemetry/3500-aquavent/get-quote.php?utm_source=solinst-&utm_medium=INS-&utm_campaign=3500-WC-&utm_term=DT-global-&utm_content=INS-3250-3500-UG-3500getquote
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Table 1–3: LevelVent Logger Technical Specifications

Level Sensor: Piezoresistive Silicon with Hastelloy Sensor

Ranges: 5, 10, 20 m (15, 30, 65 ft.)

Accuracy ± 0.05% FS

Normalization: Automatic Temperature Compensation 

Temp. Comp. Range: 0ºC to 50ºC

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Temp. Sensor Accuracy: ± 0.05ºC

Temp. Sensor Resolution: 0.003ºC

General:

Battery Life Estimate: 10 Years based on 1 reading/minute (in logger, not user replaceable)

Clock Accuracy (typical): ± 1 minute/year (-20ºC to 80ºC) 

Operating Temperature: -20ºC to 80ºC

Maximum # Readings: 40,000

Memory: Continuous or Slate mode

Communication Speed: 9600 bps Solinst USB

Size: 22 mm x 178 mm (7/8" x 7") 

Weight: 129 grams (4.5 oz.)

Wetted Materials: Delrin, Viton, 316L Stainless Steel, Hastelloy

Sampling Modes 
(using Levelogger Software):

Linear, Event & User-Selectable Schedule with Repeat Mode,  
Future Start, Future Stop, Real Time View

Measurement Rates: 0.125 second to 99 hours

Barometric Compensation: Automatic

1.1.3  LevelVent

Note: To use the LevelVent with Version 4.6 Levelogger Software, the LevelVent logger must be using Firmware Version 1.000 or 
higher. 

Figure 1-3 LevelVent Logger

LevelVent Models Full Scale Accuracy Resolution
M5 5 m (16.4 ft.) ± 0.3 cm (0.010 ft.) 0.001% FS

M10 10 m (32.8 ft.) ±  0.5 cm (0.016 ft) 0.0006% FS

M20 20 m (65.6 ft.) ± 1 cm (0.032 ft.) 0.0006% FS
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Table 1–4: AquaVent Logger Technical Specifications

Level Sensor: Piezoresistive Silicon with Hastelloy Sensor

Ranges: 5, 10, 20 m (15, 30, 65 ft.)

Accuracy ± 0.05% FS

Normalization: Automatic Temperature Compensation 

Temp. Comp. Range: 0ºC to 50ºC

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Temp. Sensor Accuracy: ± 0.05ºC

Temp. Sensor Resolution: 0.003ºC

General:

Battery Life Estimate: 8 Years - based on 1 reading/minute (user replaceable in Wellhead)

Clock Accuracy (typical): ± 1 minute/year (-20ºC to 80ºC) 

Operating Temperature: -20ºC to 80ºC

Maximum # Readings: 40,000 

Memory: Continuous or Slate mode

Communication Speed: 9600 bps Solinst USB, 1200 baud SDI-12, MODBUS RS-232/RS-485 
(various speeds), data download speed: 57,600 bps

Size: 22 mm x 178 mm (7/8” x 7”) 

Weight: 129 grams (4.5 oz.)

Wetted Materials: Delrin, Viton, 316L Stainless Steel

Sampling Modes 
(using Levelogger Software):

Linear, Event & User-Selectable Schedule with Repeat Mode,  
Future Start, Future Stop, Real Time View

Measurement Rates: 0.125 second to 99 hours

Barometric Compensation: Automatic

1.1.4  AquaVent

Note: To use the AquaVent with Version 4..6 Levelogger Software, the AquaVent logger must be using Firmware Version 1.000 or 
higher. The Wellhead must use Firmware Version 1.000 or higher.

AquaVent Models Full Scale Accuracy Resolution
M5 5 m (16.4 ft.) ± 0.3 cm (0.010 ft.) 0.001% FS

M10 10 m (32.8 ft.) ±  0.5 cm (0.016 ft) 0.0006% FS

M20 20 m (65.6 ft.) ± 1 cm (0.032 ft.) 0.0006% FS

Figure 1-4 AquaVent Logger
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1.2  Measurement Parameters

1.2.1  Level

LevelVent and AquaVent transducers detect both water (W) and barometric 
pressure (+B). However, a vent tube to surface allows barometric effects on the 
pressure sensor to be eliminated (-B). Therefore, the LevelVent and AquaVent 
provide readings of the actual pressure of just water above the pressure sensor 
zero point (A). This equation represents how the pressure sensors work: 

Figure 1-5  
Vented Logger Measurement Fundamentals

1.2.1.1  Pressure Calibration

The LevelVent and AquaVent are calibrated against a range of set reference 
points to an accuracy of 3 decimal places. During the calibration procedure, 
the logger is fully submerged in a highly accurate water bath until conditions 
are stable. The pressure is then calibrated to six separate pressure points 
covering the entire range of pressure for that particular logger to check for 
any non-linearity. The process is repeated again at two different temperatures 
to check for temperature effects. Once done, the logger is approved after all 
specifications for accuracy, precision, stability and hysteresis have been met. 
The logger should be calibrated for the life-time of the instrument, as long as 
it is used within its given technical specifications, in compatible monitoring 
environments with routine inspections, and is not physically, chemically or 
thermally damaged.

1.2.2  Temperature

The LevelVent and AquaVent record temperature compensated water levels. 
Groundwater and surface water temperature measurements are particularly 
important in situations where temperatures may fluctuate significantly, and 
where its accuracy is important in determining liquid level, viscosity and hydraulic 
conductivity. Temperature monitoring is vital in the calculation of certain 
temperature dependent contaminant reaction rates. A Platinum Resistance 
Temperature Detector is used to accurately compensate for temperature 
changes within the range of 0 to +50ºC. The LevelVent and AquaVent will 
record temperature in the thermal range of -20 to +80ºC, but outside the 
calibrated range, compensation will be less accurate.

A = (W + +B) + (-B) 
Therefore, A=W (See Figure 1-5).

 A  =  LevelVent/AquaVent readings 
 W  =  Water column height 
 +B  =  Barometric pressure detected by the pressor sensor 
 -B  =  Barometric pressure applied through the vented cable

 A  = D (depth of AquaVent Zero Point) - d (depth to water measurement)

Zero Point
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1.3  LevelVent System Components

The LevelVent 5 requires the following components to complete a monitoring system:

• LevelVent 5 Logger
• LevelVent Communication Wellhead 
• PC Interface Cable
• Vented Cable
• Solinst Levelogger Software  
 (free download on solinst.com)

Figure 1-6 Complete LevelVent 5 System LevelVent 5 Logger

Vented 
Cable

LevelVent 5 Wellhead

PC Interface Cable 
(USB) 

Note: The PC Interface Cable is 2.3 m (7.5 ft) in length. 

1.3.1  LevelVent Communication Wellhead 

The LevelVent 5 Wellhead is extremely compact and conveniently seats in the opening of a Solinst 2" Well 
Cap Assembly (a 4" adaptor is also available). 

The LevelVent 5 Wellhead has one direct read connection that is used to connect to a PC Interface Cable 
for communication with Solinst Levelogger PC Software. The Wellhead also allows direct connection to a 
Levelogger 5 App Interface or DataGrabber 5 (see separate User Guide/Instructions).

Note: There are no batteries in the LevelVent Wellhead. The battery is located in the LevelVent 5 logger and is not user-replaceable.
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The Wellhead contains a hydrophobic filter where the Vented Cable terminates at surface. There is no need 
to replace the filter, it is designed to provide protection from moisture over the lifetime of the instrument. The 
filter protects the cable from moisture, while still allowing air to flow through the vent tube, resulting in the 
cancellation effect of barometric pressure on the LevelVent 5 logger.   

A 2" Well Cap Assembly is supplied with each Wellhead, along with a Support Hanger Bracket to secure the 
Vented Cable. See Section 8.1.1 for installation instructions. 

Figure 1-7 LevelVent 5 Wellhead

Top View Bottom View
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1.4  AquaVent System Components

The AquaVent 5 requires the following components to complete a monitoring system:

• AquaVent 5 Logger
• AquaVent Communication Wellhead and Connector Cable(s)
• Vented Cable
• Solinst Levelogger Software 

Figure 1-8 Complete AquaVent 5 System

1.4.1  AquaVent Wellhead and Connector Cables

The AquaVent 5 Wellhead fits conveniently onto a 2" (50 mm) well casing using the well cap base  
(a 4" adaptor is also available). There are two options: the SP Wellhead has a 10-pin connection  
(Solinst Protocol) for cables communicating with Solinst software and accessories; the SPX Wellhead has  
an additional 12-pin connection for cables communicating with third party dataloggers or telemetry systems 
using MODBUS or SDI-12 protocols (see separate User Guides). 

Note: The Wellhead Connector Cables are 4.5 m (15 ft) in length. The Wellhead Connector Cables to be used with the SP Wellhead 
are identified with an orange band at the 10-pin connection. The 10-pin (Solinst Protocol) connection on the Wellhead is also 
labeled orange.

There are two Connector Cable options for the SP Wellhead:

• The USB Connector Cable connects to a PC for communication with Levelogger Software.
• App/DataGrabber Connector Cable for connection to a Levelogger 5 App Interface or  
 DataGrabber 5. See separate User Guide/Instructions.

Note: A Levelogger USB PC Interface Cable can also be used to connect from an App/DataGrabber Connector Cable to the USB 
Port on a PC. 

App/DataGrabber  
Connector Cable

USB Connector Cable

MODBUS RS232  
Connector Cable

SDI-12 Connector Cable

MODBUS RS485  
Connector Cable

Vented 
Cable

AquaVent 5 Logger

AquaVent 5 SP/SPX Wellhead

12 Pin 
Connections

10 Pin 
Connections
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Each Wellhead comes with 4 user-replaceable 1.5V AA lithium batteries that power the AquaVent (see Section 
8.2.1 for battery installation instructions and battery life estimates). They can last 8 years based on 1 reading 
per minute. 

Note: Solinst recommends using 1.5V AA lithium batteries in the Wellhead. 

Note: The small internal AquaVent 5 logger battery is only used to maintain the internal clock of the AquaVent 5 logger when it is 
not connected to the Wellhead, and during any firmware upgrades. 

The Wellheads contain multiple desiccants and have a hydrophobic filter where the Vented Cable terminates 
at surface. There is no need to replace desiccants or the filters, they are designed to provide protection 
from moisture over the lifetime of the instrument. The filter protects the cable from moisture, while still 
allowing air to flow through the vent tube, resulting in the cancellation effect of barometric pressure on the  
AquaVent 5 logger. 

A 2" Well Cap Assembly is supplied with each Wellhead, along with a Support Hanger Bracket to secure the 
Vented Cable. See section 8.2.2 for installation instructions. 

Figure 1-9 SP Wellhead and Connector Cable Options  

1.4.1.1 SP Wellhead LED Status

The AquaVent Wellheads have a multicolour LED light which indicates the status and operation of the 
AquaVent:

Fast Multicolour cycle 3 times: Wellhead is powering-on
Fast 10 cycles alternating blue/green: Wellhead has successfully connected to the PC using the  
USB Connector Cable
Fast 10 cycles alternating blue/red: USB connection has been dropped
Flashing yellow: The Wellhead is communicating with the PC Software over USB

Note: LED definitions for the SPX Wellhead can be found in separate User Guides for SDI-12 and MODBUS. 

USB Connector Cable

App/DataGrabber  
Connector Cable

SP Wellhead
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1.5  Vented Cable

Vented Cables contain power and communication wires, as well as a vent tube running the length of the cable. 
Vented Cables provide direct read communication from the LevelVent 5 or AquaVent 5 logger to the Wellhead. 
The vent tube and wires are jacketed in polyurethane, providing durability and protection. The cable is 8 mm 
(0.320") in diameter, while the connectors are 20 mm (0.790") in diameter. 

Note: Before the Vented Cables are shipped, the vent tubes are blown dry with nitrogen gas, and capped, to ensure no moisture 
during transport. 

Vented Cables are custom-built to length. Lengths up to 500 feet are available. 

Note: Older style Vented Cables (sold before 4/16/21 with serial numbers lower than 506326) are not compatible with 
newer style LevelVent 5 Wellheads (sold after 4/14/21 with serial numbers 495959 and up), LevelVent 5 loggers (sold 
after 4/5/21), AquaVent 5 Wellheads (sold after 7/5/21), and AquaVent 5 loggers (sold after 4/5/21)  without a small 
user modification – contact Solinst for instructions. 

Newer style Vented Cables are compatible with all versions of the Wellheads and loggers – after the new Vented Cable 
connector is fully tightened, the external o-ring on an old logger or Wellhead is visible and it is normal not to seat 
against the connector.  

1.5.1  Vented Cable Connections

The Vented Cable ends terminate with female twist connections for the LevelVent 5 or AquaVent 5 logger and 
the Wellheads. Therefore, the Vented Cables are interchangeable (i.e. it does not matter which end is installed 
on the Wellhead or logger).  

Note: For diagnostic purposes, you may wish to install the end of the Vented Cable with the serial number, to the Wellhead 
connection at surface. 

1.5.1.1  Connecting to the LevelVent Wellhead

Remove the storage caps from the connectors on the Wellhead and Vented Cable. 

Figure 1-10  Vented Cable

Note: Ensure you save all the storage caps for future use. 
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Line up the alignment pin and socket.

Gently push the Wellhead and Vented Cable together and twist slightly until you hear/feel a  
small click when the properly aligned connection is made. 

Only tighten the coupling. While holding the Vented Cable and Wellhead still, tighten the coupling until it seats. 
Do not twist the Vented Cable or Wellhead. 

Figure 1-11 Connecting a Vented Cable to the LevelVent Wellhead

Note: Do not turn the Vented Cable when connecting to a Wellhead or LevelVent logger.  Only twist the coupling. 

Vented Cable  
alignment socket

Wellhead  
alignment pin

Thumb in line 
with pin

Thumb in line with 
socket

Hold 
Wellhead 

still

Hold 
Vented 

Cable still

Only turn 
coupling
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Line up the alignment pin and socket.

1.5.1.2  Connecting to the AquaVent Wellhead

Note: See Section 8.2.2 for installing the well cap base and the Support Hanger Bracket for securing the cable when deployed. 

Remove the storage caps from the connectors on the Wellhead and Vented Cable. 

Note: Ensure you save all the storage caps for future use. 

Note: For diagnostic purposes, you may wish to install the end of the Vented Cable with the serial number, to the Wellhead 
connection at surface. 

Vented Cable  
alignment socket

Wellhead  
alignment pin

Thumb in line 
with pin Thumb in line with 

socket
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Gently push the Wellhead and Vented Cable together. Twist the cable connector slightly until you hear/feel a small 
click when the properly aligned connection is made. 

Only tighten the coupling. While holding the Wellhead and Vented Cable still, tighten the  coupling until it seats. 
Do not twist the Vented Cable or Wellhead. 

Figure 1-12 Connecting a Vented Cable to the AquaVent Wellhead

Note: Do not twist the Vented Cable when connecting to a Wellhead or AquaVent logger. Only turn the coupling. 

Hold 
Wellhead 

still

Hold 
Vented 

Cable still

Only turn coupling
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Only tighten the  coupling while holding the logger and Vented Cable still.  
Tighten the  coupling until it seats.  

Do not twist the Vented Cable or the logger. 

Figure 1-13 Connecting a Vented Cable to the Logger

Remove the storage caps from the connectors on the logger and other end of the Vented Cable. 

Line up the alignment pin in the logger with the alignment socket in the Vented Cable.  
Gently push together and twist slightly; you will hear/feel a small click when the properly  

aligned connection is made. 

1.5.1.3  Connecting to the Logger

1.5.2  Vented Cable Precautions

If the cable needs to bend during installation, ensure the vent tube does not get kinked inside the cable.  
Do not allow the vent to become squeezed or flattened inside the cable. Flattening or a kink in the tube can 
cause erroneous barometric compensation. To avoid crimping the vent tube, do not bend or coil the cable 
tighter than a 25 mm (1") radius. 

A specially designed Support Hanger Bracket is supplied with each Wellhead for securing the Vented Cable 
when deployed. See section 8 for instructions to install the bracket. 

During installation, be careful not to nick the cable on a sharp edge. Cutting through the protective jacket of 
the cable can cause moisture to access the wiring inside, which can cause communication issues, or moisture 
to travel down the cable.

Note: Ensure you save all the storage caps for future use.  

Note: Do not twist the Vented Cable when connecting to a Wellhead or logger. Only turn the coupling. 

Hold logger still

Hold Vented 
Cable still

Only turn 
coupling
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2.  Solinst Levelogger Software

This Windows® based software provides many convenient features. You can view and program datalogger 
settings, begin logging sessions, monitor real-time readings, download data, manage data files, perform data 
adjustments, and save and export data files. 

Note: It is always recommended to use the most recent version of software and firmware. Let Solinst keep you up-to-date with 
each new software and firmware release. Register your software at: www.solinst.com/Registration/ to receive these updates 
automatically.

Levelogger Software is used to program all Solinst dataloggers. The software intuitively detects the type of 
datalogger connected, and will only display the setting options specific to that datalogger type. 

2.1  System Requirements

The minimal hardware and software requirements for software installation and operation are:

Hardware Software

Processor: 1 GHz or faster processor or SoC OS: Windows 10

RAM: 1 GB for 32-bit or 2 GB for 64-bit

Hard disk space: 128 MB

Display: 800 x 600

Ports: USB or RS-232

Communication port setting for datalogger communications:

Bits per second 9600

Data bits 8

Stop bits 1

Flow control None

http://www.solinst.com/Registration/
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2.2  Software Installation

Web Download

1. Download the newest version of Levelogger Software by visiting: www.solinst.com/downloads/ 

2. If the installer does not automatically start, to activate the software install click on the ‘setup.exe’ file.

3. The Software Installation Wizard will guide you through the remaining installation process. Figure 2-1 shows  
 the Software Installation Wizard.

4. Restart the computer after installation is completed. Default Directory is:  
 C:\Program Files\Solinst\Levelogger4_6

Figure 2-1 Found New Hardware Wizard
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2.3  Software Communication

Levelogger Software is Windows based, and is therefore used with a desktop or laptop PC. 

The LevelVent communicates to a laptop or desktop PC using a USB PC Interface Cable connected to the 
LevelVent Wellhead. 

Figure 2-2 LevelVent 5 Communicating with Levelogger Software

Figure 2-3 AquaVent 5 Communicating with Levelogger Software

The AquaVent communicates to a laptop or desktop PC using a USB Connector Cable connected to the 
AquaVent Wellhead. The USB Connector Cable connects to the 10-pin (Solinst Protocol) connector on a  
SP or SPX  Wellhead. 
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3  Software Startup, Configurations and Settings

3.1  Startup

Plug in the USB cable before starting the Levelogger Software.

To start the software, click , or click the Start button and select:

Programs > Solinst > Levelogger 4 > Levelogger 4.6

Once the program is started, you can set up the parameters for the Software. 

3.1.1 Software/Firmware Update Checks

Each time the software is opened, it automatically checks on-line for software updates. If there is an update, 
"Software Update Available" will appear in the top right of the menu bar. When you click the message, it will 
open a web page where you can download the software update.

Note: Your PC must have an internet connection to check for software and firmware updates.

The Software also checks for firmware updates once you have retrieved settings from a connected datalogger 
(see Section 4). "Firmware Update Available" will appear in the top right menu bar. Clicking the message 
will open a web page where you can download the firmware update. See Section 11 for firmware update 
instructions.

Note: You can also check for updates using the Help menu.

3.2  Configuration and Settings

3.2.1  Data Directory

The program will save downloaded data to the following default directory: 
<C:\Program Files\Solinst\Levelogger4_6\Data>  
unless otherwise specified in the Default Directory field of the Application Settings window (Figure 3-1). 

Click the Configuration menu at the top of the program window, select Application Settings and input or 
navigate to a different folder destination. After completing the Application Settings, click the OK button to 
confirm and save the settings. 

Figure 3-1 Application Settings Window
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3.2.2  File Name Settings

From the Application Settings window in the Configuration menu, you can set what information will be 
included in your default file names of downloaded data  (see Figure 3-1). You can include Start Date, Stop 
Date, Date Created, Serial Number, and Location. Check-off the information you would like included. 

After completing the Application Settings, click the OK button to confirm and save the settings. 

3.2.3  Default File Type

From the Application Settings window in the Configuration menu, you can set the default file type you would 
like to use for downloaded, saved and exported data files. You can select between either *.xle (default) or *.lev 
file types (see Figure 3-1). For more information about the two file types, see Section 5.1.1. 

You also have the option to choose between North American Format for decimal separators (period symbol) 
or based on the System Locale Format, for exported *.csv files.  

After completing the Application Settings, click the OK button to confirm and save the settings. 
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4  Datalogger Programming

After you start Levelogger Software, the Main Window will appear, with the Datalogger Settings tab open. 
Select the appropriate device from the centre Com Port drop-down menu. 

Click
 

 to retrieve the current settings from the connected datalogger.  

Note: Click on  icons to get an explanation of that software feature.

Figure 4-1 Dataloggers Settings Tab - LevelVent 5

Figure 4-2 Dataloggers Settings Tab - AquaVent 5

Note: After retrieving the settings, If the AquaVent Wellhead batteries have drained to 20% charge or lower, a warning message 
will appear to replace the batteries. 



Vented Dataloggers User Guide

Page 26

4.1  Datalogger Settings

After you have retrieved the settings of the connected datalogger, the Datalogger Settings tab will identify the 
Instrument Type, Serial Numbers, Firmware Version(s), Project ID, Location, Battery Level and the Channel 
Settings.

• Instrument Type: will display the model of the attached datalogger, i.e.: M5
• Serial Number: the unique serial number of the attached logger will be displayed. If an AquaVent is  
 connected, the serial number of the Wellhead will also be displayed. 
• Firmware Versions: shows the firmware version of the connected logger. If an AquaVent is  
 connected, the firmware version of the Wellhead will also be displayed.
• Project ID: input your own identification system. The Project ID is limited to 32 characters.
• Location: input specific site / location information. The location is limited to 32 characters.

The MODBUS and SDI-12 Address, and Baud Rate settings are only for use with the AquaVent SPX Wellhead. 
See separate User Guides for communication using MODBUS and SDI-12 protocols. 

4.1.1  Setting Up Channel Information

In the lower left portion of the Datalogger Settings tab is the area for setting channel parameters (level, 
temperature). The software will detect the available channels when the datalogger settings are retrieved.

4.1.1.1  Level Channel (Ch1)

• Identification describes the measurement parameter of the channel and has already been  
 configured as ‘LEVEL’. The channel can be re-named to suit each project. The channel monitors  
 water column equivalent pressure. The Identification field will be the channel heading, data column  
 heading and graph line name when viewing the data. Identification is limited to 32 characters.
• Unit refers to the channel’s unit of measurement. There are six options for water level measurement:  
 m (default), cm, ft, kPa, bar, and psi. 

  Note: Readings can be converted to other units using the Data Wizard.

• Offset refers to an adjustment, such as the distance between the tip of the logger and the monitoring  
 well cap or static water level. It is recommended that the value of 0.00 be used, as this keeps all  
 subsequent readings relative to the tip of the logger. The reference range is -300 m to 5000 m or  
 -1000 to 16,400 ft.

  Note: Readings can be corrected or offset with respect to a specific reference elevation or datum for a much  
  wider spectrum of numeric offsets as part of the Data Wizard.

Figure 4-3 datalogger Channel Setup

4.1.1.2  Temperature Channel (Ch2)

• Identification describes the measurement parameter of the channel and has already been configured  
 as 'TEMPERATURE’.  The channel can be re-named to suit each project. The Identification field will  
 be the channel heading, data column heading and graph line name when viewing the data.  
 Identification is limited to 32 characters.
• Unit refers to the channel’s unit of measurement. The temperature channel can be set to °C (default)  
 or ºF.
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4.2  Datalogger Information

The Datalogger Information section shows the Status of the attached datalogger (i.e.: Started, Stopped, 
Future Start) and the Start Time and Stop Time of the datalogger. When a Future Start and/or Stop time 
is set (see Section 4.9), the Start Time and Stop Time fields will fill in. The fields will update each time the 
datalogger is stopped and started.

Figure 4-4 Datalogger Information

4.3  Datalogger Memory

The Datalogger Memory section shows the amount of memory used, and the amount of memory remaining 
(number of readings). 

Figure 4-5 Datalogger Memory Remaining

4.4  Datalogger Time

The Datalogger Time section provides the controls for setting the datalogger clock. If you want to synchronize 
the datalogger’s clock to the computer clock, click Synchronize to set the time in the datalogger. 

If you start the datalogger without synchronizing the clock and the time difference between the datalogger and 
the PC is more than 3 seconds, the software will give you a message asking ‘Do you want to synchronize the 
logger time to system time?’.  Click Yes to synchronize the clock. 

Note: To synchronize to a different time/time zone you first must adjust the computer time using the Windows Operating System 
Date and Time Settings menu. Then re-start the Solinst Levelogger Software and synchronize your dataloggers to the new time. 

Figure 4-6 Datalogger Time
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4.5  Datalogger Sampling Mode

The Datalogger Sampling Mode section allows you to choose the sampling measurement type. Options for 
the LevelVent and AquaVent are Linear, Event Based and Schedule.

Linear refers to a set time interval between collection of readings. Sample Rate can be any number from 
0.125 seconds to 99 hours. 

Note: Typical battery life of the LevelVent 5 logger is 10 Years, based on 1 reading per minute. More rapid readings will reduce the 
battery life. For example, if a LevelVent is setup in Continuous Mode at a sampling rate of 1 second, the battery will be depleted in 
approximately 4 months.

Note: The battery life of the AquaVent Wellhead is 8 Years, based on 1 reading per minute.  More rapid readings will reduce the 
battery life. For example, if an AquaVent is setup in Continuous Mode at a sampling rate of 1 second, the battery will be depleted 
in approximately 3 months.

Figure 4-7 Linear Sampling Setup

Event Based sample collection is the most memory efficient means of data collection. In Event mode, the 
datalogger will be activated at every defined ‘Sample Rate’ to check if readings have changed by the selected 
‘Change’ from the last recorded reading. 

‘LEVEL’ or ‘TEMPERATURE’ is the selected parameter where change is monitored. The datalogger will 
record a new reading only if the specified change in the parameter has occurred, at the specific point in time, 
as defined by the ‘Sample Rate’.

Note :In Event based sampling mode. the LevelVent 5 and AquaVent 5 have a total memory of 60,000 readings of level and 
remperature.  In Event Based sampling mode, the LevelVent and AquaVent have a total memory of 24,000 readings of level and 
temperature.

A default reading will also be stored in the datalogger memory, every 24 hours from the last recording, if no 
‘Change’ occurs.

Note: In Event Based sampling mode, battery consumption is mainly a function of sampling rate.  Therefore, with a smaller 
sampling interval, battery power will be used up quickly whether readings are stored or not.

Figure 4-8 Event Based Sampling Setup
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Schedule Sampling allows you to select a logarithmic style sampling schedule adapted to the needs of each 
application. 

Schedule Sampling is set by using the plus and minus buttons to add or subtract line items in the Schedule 
window. The maximum number of line items in a schedule is 30, each with its own sampling interval of 
seconds, minutes or hours and duration of seconds, minutes, hours, days or weeks. A 'Pause' interval can 
also be selected, which stops the datalogger from recording for the specified duration.

Note: A schedule can be saved and applied to other dataloggers by saving the Settings file (see Section 4.7).

Running totals of the number of readings still available, from the total possible, and the run time to date 
are shown. If the number of readings selected exceeds the datalogger’s memory capacity, an error message 
appears.  

By checking Repeat, the datalogger will continue to run through the schedule until its memory is full, or it is 
stopped.

Figure 4-9 Schedule sampling Setup

4.6  Datalogger Memory Mode

Datalogger Memory Mode selection will only appear when Linear sampling mode is selected. When using a 
datalogger in Linear Mode, there is a choice of Continuous Logging (wrap around) or Slate Logging

.  

Linear, Event Based and Schedule sampling modes can only use the Slate Mode option. 

In Continuous Logging, the new log is started at the end of any previous log and continues logging, eventually 
recording over the first logged data. As one of the download options is to ‘Append Data’, Continuous 
Logging can be a preferred choice when logging long-term (see Section 5.1.2). 

In Slate Logging, the new log is also started at the end of any previous log, but will stop recording after 
150,000 (or 40,000) readings, so that the beginning of the current log will not be written over.

Figure 4-10 Datalogger Memory Mode
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4.7  Saving and Retrieving Datalogger Settings Files

To store settings as defaults, click . It will store the settings of the datalogger into an *.dtf file as a series 
of defaults. The *.dtf file will save the Project ID, Location, Sample Mode, Sample Rate, Channel ID, Unit, 
and Offset. 

To retrieve settings from defaults, click  from a selected *.dtf file. This is particularly useful if 
programming several dataloggers with similar or identical settings. Keep in mind that Project ID and Location 
identification information will be identical and should be distinguished from logger to logger or monitoring 
point to point.

4.8  Datalogger Zero

Before starting and deploying your datalogger, you can “Zero” it to current atmospheric pressure. This will 
ensure that it is reading 0 in air for the level reading. 

Note: To check your datalogger’s readings in air, use the Real Time View function. See Section 7.

Figure 4-11 Datalogger Zero

After clicking Zero, the current time will be displayed as the “Last Zero Time”. 

Note: You can not perform a Datalogger Zero while the datalogger is running. 

Figure 4-12 Last Zero Time

The Datalogger Zero can be cleared using the Diagnostic Utility. See Section 10.
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4.9  Starting and Stopping the Datalogger

Starting the Datalogger

There are two ways to start logging: Start Now or by programming a Future Start time.

To start logging immediately, do not fill in a Future Start time and click, . It should say Start Now below 
the icon to indicate an immediate start. 

Before starting a LevelVent 5 or AquaVent 5 datalogger, a pop-up window will indicate how much memory 
is available. Selecting “Yes” ignores the message and starts the datalogger immediately with the remaining 
available memory. Selecting “No” gives you the chance to access the Data Control tab to download and/or 
delete data files using the “Download and Delete Files” option, to free-up memory (see Section 5).

Figure 4-13 Remaining Memory Warning

When starting a new logging session with a previous version LevelVent or AquaVent, any data 
from the previous recording session will be erased (see Section 5 for downloading data).

Note: If a setting has been changed, it will be highlighted in yellow as a reminder before the datalogger is started. If a setting has 
been entered incorrectly, it will be highlighted in red.

After selecting “Yes” any changed settings will automatically be applied to the datalogger, and it will start 
logging. Datalogger Status will change from Stopped to Started. 

Figure 4-14 Starting the Datalogger Immediately

After the datalogger is started, and begins collecting readings, the Start icon will be greyed out, and only the 
Stop icon and Future Stop settings will be active. 

Check Future Start 'At' to set logging to start at a later date and/or time. This Start mode is referred to as 
Future Start in the Status field. Click to apply the Future Start time and any changes to the datalogger 
settings.

When the Future Start time is reached, the datalogger will start logging and the Status will change from Future 
Start to Started.

Note: Retrieve the datalogger settings in order to refresh the status (i.e. when the status changes from Future Start to Started).

Figure 4-15 Future Start Setting
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Stopping the Datalogger

There are two ways to stop logging: Stop Now or at a programmed Future Stop time for the datalogger.

To stop the datalogger immediately when it is logging, click , (it should say Stop Now below the icon).

The datalogger can be stopped at any time before it reaches the maximum reading capacity. Starting again 
begins a new recording session and clears previously stored data readings.

Figure 4-16 Stopping the Datalogger immediately

To program a Future Stop time for your datalogger, check Future Stop 'At' and fill in the desired stop time. 
The Future Stop time will be applied to the datalogger once is selected for an immediate or future start. 

You can also program a Future Stop time after you have started the datalogger, by checking Future Stop 'At' 
and filling in the desired stop time. Select to apply the Future Stop time (it should say Future Stop 
below the icon). 

Note: If you have set a Future Stop time, but wish to stop the datalogger immediately, uncheck the Future Stop ‘At’ box, and the 
Stop icon should say Stop Now. Click the icon to stop logging.

The Stop Time should be shown in the Datalogger Status section.

Figure 4-17 Future Stop Setting

It is critical to note that when the datalogger logs data in Slate mode, it means it will record data until 
stopped or their memory is full. For this reason, it is important to determine, based on your start time and 
sampling rate, the date and time at which the memory will be full and the datalogger will stop recording. The 
datalogger records in Slate mode if Event or Schedule logging. Linear mode, however, can be set to Slate or 
to Continuous logging.
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5  Data Control

(Downloading and Viewing Data using Levelogger Software)

Click the Data Control tab on the Main Window. From the Data Control tab you can download data from a 
datalogger, display data in tabular or graphic format, and save and export data files.

Figure 5-1 Data Control Tab

Click to open a *.xle or *.lev file. Multiple files can be opened at the same time and are available for 
viewing by clicking the File Name Tab on top of the data table. 

Note: When you click on a data point in the graph, the corresponding data  point will be highlighted in the table. You can also 
highlight a section of data in the graph.

All the datalogger settings and the channel information effective during data collection are shown on the 
top left of the window. The bottom left sections of the window are used to display information after a data 
compensation has been performed, such as offsets or unit conversions (see Section 6).

5.1  Downloading Options and Saving Data Files

5.1.1  Default File Format

The default file type for Levelogger Software Version 4 and up is *.xle, unless changed to *.lev in the Application 
Settings (see Section 3.2.3). Previous Levelogger Software used *.lev files as the default. The *.xle file type is 
a *.xml format, which allows for enhanced functionality. The *.xle files can be exported as *.xml files, which 
can be integrated into external database programs.  

Note: The default file type is *.xle, unless changed in the Application Settings (see Section 3.2.3).

The *.lev files of previous downloads are compatible with Levelogger Software Version 4 and up, however, 
*.xle files are not compatible with previous software versions. To ensure compatibility, all Levelogger Software 
versions allow data to be exported as *.csv files for use in external spreadsheet programs. See Section 5.3 for 
Export options.
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5.1.2  Downloading Data

Before downloading data you must select the Com Port that the datalogger is connected to and retrieve the settings from the 
attached datalogger by clicking               in Datalogger Settings tab.

Click from the Data Control tab to download data from a connected datalogger. There are four download 
options to choose from.

For LevelVent 5 and AquaVent 5 dataloggers, they are: All Data, Append Download, Partial Download 
and Download and Delete Files. 

For previous LevelVent and AquaVent dataloggers, they are: All Data, Append Download, Partial 
Download and Recover Previous Log.

If you select All Data, the program will download all the data from the current logging session of a datalogger 
into a *.xle file. 

The default directory for saved data is in the ‘Data’ folder: <C:\Program\Files\Solinst\Levelogger4_6\Data>. 

If you select Append Download, the program will append the data in an opened *.xle file from the datalogger. 
The opened *.xle file and the attached datalogger should have the same serial number and start time, otherwise 
an error will occur.

Figure 5-2 Partial Download Window

If you select Partial Download, a Partial Download Selection Window will open. The window shows the time 
stamp of the first and last reading in the logging session. Use the slider to select the time interval you would 
like data from. Once you click OK, all the data within that time will be downloaded to a *.xle file. 
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Figure 5-4 File Write Error Message

For LevelVent 5 and AquaVent 5 dataloggers, if you select Download and Delete Files, the software will 
bring up a window with a list of logging sessions currently stored in the datalogger’s memory. Select the files 
you want to download. Each logging session will be saved as a separate *.xle file. 

To access the full memory, select Delete All Files and you will be prompted with a “Warning All Data in the 
logger will be erased!  Continue?”  Select Yes, or No, to proceed.  (Selecting individual files for deletion, is 
not an option.) This will free-up memory before starting a Levelogger 5 Series datalogger (See Section 4.9).

Figure 5-3  Download Files List

For previous version LevelVent and AquaVent dataloggers, if you select Recover Previous Log, the software 
will try to recover the data from the previous log session and download the data to a *.xle file.

Once the data is downloaded from a datalogger, it is automatically saved in a temporary file.  

5.1.3  Saving Data

Click to save the data in a specific *.xle file. 

The default directory for saved data is in the ‘Data’ folder:  
<C:\Program\Files\Solinst\Levelogger4_6\Data>. 

However, the default directory for saved files can be changed by clicking the 
Configuration menu at the top of the program window, selecting ‘Application 
Settings’ and inputting or navigating to a different folder destination. If an 
error is experienced in saving your first data file such as depicted in Figure 
5-4, you may not have file writing privileges to the default directory. In this 
case, create and set as the default file save folder, a new data folder within the  
My Documents folder and attempt the file save procedure again.
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5.2  Graph Manipulation and Zoom Function

To perform the Zoom In function on the graph, click . 

To perform a Zoom Out function on the graph click . Click to undo all the zoom functions.

The Zoom functions can also be used for data selections in the graph.

Note: Right click, and drag the mouse to scan the data graph.

Click to open the Graph Option Dialog. The Graph Dialog is shown in Figure 5-5.

Figure 5-5 Line Option Window

The Line Option is used to adjust the style and colour of the line in the graph for each channel. The user can 
also select the shape of the data marker or remove the data marker.

Figure 5-6 Title and Axis Option window

The Title and Axis Option is used to enter the title of the graph and change the Y axis label or user selected 
scale. Check the Best Fit box to enable the software to determine the best fit scale. If the Best Fit box is not 
checked, the user has to enter a maximum and minimum value of the selected channel. The X axis is logging 
time.
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There is the option to show Combined Plot graphs or Separated Plot graphs of the data. Choosing a Combined 
Plot will show the data from each of the channels in one graph. The Separated Plot option will show a 
separate graph for each data channel. 

Figure 5-7 Combined and Separated Plot Graphs

There is also the option to view more than one graph at a time. Click and drag a File Name Tab and drop 
it when you see a shaded area on the window to open a separate graph of that data file. You can view any 
number of graphs at one time by re-sizing your window as required.

Figure 5-8 Viewing Two Graphs
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5.3  File Export and Print Function

Data can be exported in *.csv (comma separated value) file format or *.xml (extensible markup language) file 
format by clicking File > Export > Data or 

The *.csv and *.xml file formats are supported and can be imported by most spreadsheet and database 
programs.

Also, the data graph can be exported to a *.bmp file or a *.png file by clicking File > Export > Graph. 

The Datalogger Settings, data table and data graph can be printed. Click File > Print Preview, to open the 
Print Preview window. Figure 5-9 shows the print preview of the Datalogger Settings. The Datalogger Settings 
are always on the first page of the document. The data graph is on the second page of the document and the 
rest of the document is the data table. 

Click Print..., to open the print dialog. You can choose to print the entire document or just a selection. You 
can also click File > Print, to open the print dialog.

Figure 5-9 Print Preview Screen
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6  Data Compensation

Data Compensations, such as Manual Data Adjustments and Parameter Adjustments can be performed 
automatically using the software Data Wizard, or manually, by exporting data to an external spreadsheet 
program.

6.1  Data Wizard

Open the Data Wizard tab. The first step is to select your Data Compensation Path. The LevelVent 5 and 
AquaVent 5 will only have the Advanced option available. 

Note: Multiple data files can be compensated at once.

The Advanced option allows you to perform Manual Data Adjustments and Parameter Adjustments.

Figure 6-1 Data Wizard

Manual Data Adjustment allows you to enter a manual water level measurement or reference point as a 
field zero, which all water level readings can then be adjusted to. There is the option to convert readings to  
Depth to Water Level measurements (e.g. from the top of a well casing to water level), or Elevation of Water 
Level measurements (e.g. above sea level).

Note: Manual Data Adjustment,  and Parameter Adjustments are useful for correcting data files to make data consistent across a 
project.  

Parameter Adjustments allow you to change data to different units of measurements, add an offset, or adjust 
density.

• Unit conversion allows you to convert level readings in a data file to different units (m, cm, ft, kPa,  
 bar or psi), or temperature readings to ºC or ºF,
• Offset allows you to enter any value, positive or negative, which will be added to each reading  
 in the selected data file to be offset by that amount. It is recommended to stay with the default zero  
 value, unless a known offset has been determined (e.g. to correct for pressure sensor drift. See  
 Solinst Technical Bulletin: Understanding Pressure Sensor Accuracy, Precision, Resolution & Drift.
• Density Adjustment corrects the range of the level channel in the data file based on a user input  
 adjustment of fluid density. The range of the density adjustment is from 0.9 kg/L to 1.1 kg/L.

https://www.solinst.com/onthelevel-news/water-level-monitoring/water-level-datalogging/understanding-pressure-sensor-accuracy-precision-resolution-drift/
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When you select Advanced compensation, the Data Compensation Options window will open. 

Figure 6-2 Data Compensation Options

First, you will select how you want your data displayed (Manual Data Adjustment):

• Depth to Water Level adjusts water level data to represent depth to water level readings (from the  
 top of a well casing or other reference point) by entering a field zero, such as a manual depth to  
 water level measurement. Adjustments can be made to one or more data files. 
• Elevation of Water Level adjusts water level data to represent elevation of water level readings  
 (above sea level or other reference point) by entering a measuring point elevation, and a field zero,  
 such as a staff gauge measurement from that point. Adjustments can be made to one or more data  
 files.
• Parameter Adjustments Only allows you to adjust one or more data files to different units, density,  
 etc., while keeping the sensor diaphragm (zero point) as the reference point for datalogger.

Next, you will select Yes or No to performing any Parameter Adjustments on the data files (will not be active 
if you selected Parameter Adjustments Only).

Click Next, after you have selected all of your Data Compensation options. 
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In the next window, you will choose the data file(s) you would like to use in the compensation. Any files you 
have open in the Data Control tab will be listed. 

Use the directory on the left of the window or click  to open any other data files you would like to 
compensate. Ensure the files you want to compensate are highlighted in the list. Do this by clicking the file 
name. To de-select a file, click again. Select Next to continue.

Figure 6-3 Selecting Files for Compensation

If you have selected yes to Parameter Adjustments, or selected the Parameter Adjustments Only option, 
in the next window you will enter these. If you did not select to change any parameters, this window will not 
be shown.

Note: When adjusting Units, if you select apply to all, the same unit change will be applied to all of the files being compensated at 
that time.

Figure 6-4 Parameter Adjustments
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Next, for each selected data file, you will enter the Field Zero(s) you would like to use to manually adjust your 
water level data. (If you have selected Parameter Adjustments Only, this window will not be shown.)

For Depth to Water Level adjustments, enter a Field Zero (A). If the static water level is below your Field 
Zero measurement, the Field Zero is input as a positive value (e.g. a manual water level meter measurement 
taken from the top of a well casing. See Example 6.1). If the static water level is above your Field Zero, the 
Field Zero is input as a negative value (such as in a flowing artesian sealed wellhead condition).

The Time the Field Zero measurement was taken must replace an actual reading in the data file. This is selected 
from the drop-down menu showing all time stamps in the data file. Click ‘Add’ to apply the adjustment. If you 
need to change a Field Zero, click ‘Update’ after any edits.

Note: The date and time of measurement of the Field Zero must be recorded to complete the adjustment. The Field Zero must 
replace an actual reading the data file. I.e. take a manual measurement immediately after starting the datalogger, and note that 
time. 

Figure 6-5 Manual Data Adjustment - Depth to Water Level
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Example 6.1 Depth to Water Level Adjustment

When using a manual depth to water measurement taken from the top of a 
well casing as a Field Zero, enter it as a positive value (e.g. 10 m). 

In your adjusted data file, your readings will increase in value as the water 
level decreases. This is because the depth to static water level from the top 
of the well casing is increasing. The adjusted readings will decrease in value 
as the static water level rises.

Original Data
(height of water above sensor)

8.75 m 8.50 m 8.75 m 9.5 m 9.75 m

Adjusted Data  
(depth to water)

(A) 10.0 m 10.25 m 10.0 m 9.25 m 9.0 m
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For Elevation of Water Level adjustments, enter a Measuring Point Elevation (A) and a Field Zero (B) 
from that Measuring Point. 

If the static water level is below your Measuring Point, the Field Zero is input as a positive value  (e.g. if you are 
using a manual depth to water measurement as a Field Zero, from the top of a well casing as the Measuring 
Point).

If the static water level is above your Measuring Point, the Field Zero is input as a negative value (such as in a 
flowing artesian sealed wellhead condition). The Measuring Point elevation may also be entered as a negative 
value.

Figure 6-6 Manual Data Adjustment - Elevation of Water

The Time the Field Zero measurement was taken, must replace an actual reading in the data file, and is selected 
from the drop-down menu showing all time stamps in the data file. Click ‘Add’ to apply the adjustment. If you 
need to change a Field Zero, click ‘Update’ after any edits.

Note: The date and time of measurement of the Field Zero must be recorded to complete the adjustment. The Field Zero must 
replace an actual reading the data file, i.e. take a manual measurement immediately after starting the datalogger, and note that 
time. 

You can make multiple adjustments to one data file by selecting ‘Add’ again to enter another Field Zero.  
All readings after this Time, will be adjusted to this second measurement. You can add as many adjustments to 
one data file as you would like (as long as it doesn't exceed the total number of readings in that file).

Select Next to complete the compensation. 
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The compensated data will automatically be saved in a new *.xle file. The default file name will be the <original 
file name> with the word <compensated> added to the file name prefix. Alternatively, the user can rename 
the compensated file by saving it in the Data Control tab. Do not change or delete the file extension. All data 
files are saved to the default location: <C:\Program Files\Solinst\Levelogger4_6\Data>.

Note: All data files are saved to the default location: <C:\Program Files\Solinst\Levelogger4_6\Data>. However, the default 
directory for saved files can be changed by clicking the Configuration menu at the top of the program window, selecting 
‘Application Settings’ and inputting or navigating to a different folder destination. 

The next window will show the results of the compensation. If the compensation was unsuccessful, there 
will be an explanation in the Reason column. You can still view the compensated file in the Data Control 
tab, by clicking ‘Open’ in the Action column. If the compensation is successful, select ‘Open’, to view the 
compensated data file in the Data Control tab. 

Figure 6-7 Data Compensation Results
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From the Data Control tab, you can view the data, save the compensated file with a new filename and/or 
export the data (see Section 5).

All the original datalogger settings and the channel information effective during data collection are shown 
on the top left of the window. The bottom left sections of the window are used to display the compensation 
information. 

Figure 6-8 Viewing Compensated Files in the Data Control Tab
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7  Real Time View

Click the Real Time View tab from the Main Window (Figure 7-1). The purpose of this tab is to provide  
on-screen measurement as data is being recorded by the connected datalogger. The data is displayed in tabular 
and graphical format. All the channel information and datalogger settings are displayed on the left of the 
window.  

First, select a non-logged view rate  . This rate can be set independently of the logging period 
of the datalogger and does not interfere with any logging taking place in the LevelVent 5 or AquaVent 5 itself.

Checking, Enable Manual Data Adjustment, allows you to enter a datum/ field zero (e.g. depth to water level) 
to which the change in Real Time View level measurements are then adjusted against. This is only available 
when you are taking readings in m, cm, or ft.

Datalogger settings can not be changed in the Real Time tab.  Changes must be made in the Datalogger Settings tab. The changes 
are applied when the Real Time readings are started .

Real Time View readings can be displayed as a graph or in tabular format. The same graphing options as the 
Data Control tab are available for Real Time View readings. Real Time View readings are being recorded 
within the Levelogger Software and prior to closing the window, they can be saved by exporting the data into 
a *.csv file, by choosing the file export option .

To start the current readings, click . The readings will be displayed immediately.  

To take a reading at any specific time, click the  button and that reading will be added to the displayed 
data. To turn the Real Time View monitoring off, decide if you want to save the data as described above, and 
simply click .

Figure 7-1 Real Time View Window
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8  Vented Datalogger Installation

8.1  Installing the LevelVent

The LevelVent 5 system is designed to be conveniently installed on a 2" well casing (4" with an adaptor). 
However, other installations are acceptable, if proper precautions and recommendations are followed. 

The LevelVent Wellhead has an IP  rating of 64 (dust and splash resistant), so should not be submerged at 
anytime. It can be secured inside an enclosure, however, it must be vented to equalize atmospheric pressure. 
The Wellhead measures 30 mm x 76 mm (1.2" x 3.0").  

Begin by ensuring you have correctly connected your LevelVent 5 logger to the Vented Cable, and the  
Vented Cable to the Wellhead. See Section 1.5.1 for connection instructions. See Section 8.1.1 for installation 
using the 2" Well Cap Assembly and the Support Hanger Bracket.

8.1.1  Installing LevelVent in 2" Well

Each LevelVent Wellhead comes with a Support Hanger Bracket and a 2" Well Cap Assembly, which consists 
of an insert, well cap base and well cap. 

The 2" Well Cap Assembly insert has two openings which can be used to install and support a  
LevelVent Wellhead. The second opening can be used to take manual water level measurements while the 
LevelVent 5 logger is recording down-well. When the openings are not in use, two red plugs are supplied with 
the assembly.

Note: A third 0.7" ID access hole allows additional monitoring equipment in the well, such as a Water Level Meter for manual field 
measurements.  

Note: To accommodate 4” wells, a separate adaptor is available for use with the 2” well cap base.

Adaptor

Cap

Base

Insert

Plugs

Support Hanger 
Bracket

Figure 8-1 2" Well Cap Assembly, Adaptor, and Support Hanger Bracket
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The steps below show how to install the LevelVent using the Support Hanger Bracket and 2" Well Cap 
Assembly:

Connect the Vented Cable to the Wellhead and the LevelVent 5 logger. See Section 1.5.1 for more details.

Note: For diagnostic purposes, you may wish to install the end of the Vented Cable with the serial number, to the Wellhead 
connection at surface. 

Slide the well cap base onto the well casing. Do not secure it at this point.   

Place the Support Hanger Bracket in the well cap base so it seats on the shoulder in the base. Place the insert into the  
well cap base.

Note: There are three holes in the top of the Support Hanger Bracket that can be used to secure it in the well cap base with screws. 
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Remove one of the red plugs from the insert. Lower the LevelVent 5 logger and Vented Cable through the opening and down the well until the 
Wellhead seats in the insert. Remove the other red plug from the insert and take a manual  

depth to water measurement for your records.

Lift the well cap base with Support Hanger Bracket and insert from the well casing. Wrap the Vented Cable around the Support Hanger Bracket and slide into 
the cutouts to secure the cable to the bracket. 

Note: The holes in the bracket can accommodate twist ties or zip ties to secure the cable to the bracket  if desired. 

Lower the well cap assembly back onto the well casing. Secure the well cap base to the well casing if desired. Install the well cap. Note, you may need 
to remove the dust cap from the LevelVent Wellhead before installing the well cap. 

Figure 8-2 Installation using the 2" Well Cap Assembly and Support Hanger Bracket
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8.2  Installing the AquaVent

The AquaVent 5 system is designed to be conveniently installed on a 2" well casing (4" with an adaptor). 
However, other installations are acceptable, if proper precautions and recommendations are followed. 

Note: Consider the use of an extended top cap style protective well head. This would allow full access to the AquaVent 
Wellhead components at the top of the monitoring well. 

The AquaVent Wellheads have an IP rating of 64 (dust and splash resistant), so should not be submerged at 
anytime. They can be secured inside an enclosure, however, it must be vented to equalize atmospheric pressure. 
The Wellhead measures 102 mm x 140 mm (4.0" x 5.5"). 

Ensure you connect your AquaVent 5 logger to the Vented Cable, and the Vented Cable to the Wellhead. See 
Section 1.5.1 for connection instructions. See Section 8.2.2 for installation using the well cap base and the 
Support Hanger Bracket.

8.2.1  Installing AquaVent Wellhead Batteries

Note: After retrieving the settings in Levelogger Software, If the Wellhead batteries have drained to 20% charge or lower, a 
warning message will appear to replace the batteries. 

Each Wellhead uses four (4) 1.5V AA replaceable lithium batteries. To install the batteries, follow the steps 
below:

1. Unscrew the top of the Wellhead to access the battery compartment. 

2. Carefully remove the battery holder from the compartment. 

3. Install the four batteries in the holder. Ensure proper polarity when placing the batteries, paying attention to the  
 positive {+} and negative {-} symbols etched in the holder.  

4. Slide the battery holder back into the compartment. Ensure proper alignment; the spring contacts in the  
 housing should be lined up with the protruding contacts on the bottom of the battery holder. 

5.  Screw the top cap firmly back onto the Wellhead. 

6. After replacing the batteries, to reset the battery indicator in the Levelogger Software, use the Diagnostic Utility  
 (see Section 10.6). 

Figure 8-3 Installing Wellhead Batteries

AquaVent Sampling Rate Battery Life Estimate

8 readings per second 10 days

1 reading per second 3 months

1 reading per minute 8 years

8.2.1.1 Wellhead Battery Life Estimates
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8.2.2  Installing AquaVent in 2" Well

The Support Hanger Bracket is used to secure the Vented Cable to the Wellhead when deployed. 

The support system consists of the 2" well cap base and the Support Hanger Bracket (both come with the 
Wellhead). To accommodate 4" wells, an adaptor is available for use with the 2" well cap base.

Note: A 2”  Well Cap Assembly comes with each AquaVent Wellhead. Only the base of the assembly is needed to install the 
Support Hanger Bracket. The cap can be used later to seal a well, if the AquaVent Wellhead is removed.

Install the well cap base on the well casing.  

The steps below show how to install the AquaVent using the Support Hanger Bracket in a 2" well:

Adaptor

Cap

Base

Support Hanger 
Bracket

Figure 8-4 Well Cap and Base, Adaptor and Support Hanger Bracket
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Wrap the top end of the Vented Cable around the Support Hanger Bracket and insert into the cutouts to secure the cable to the bracket. Leave about 2" of 
slack in the cable above the top of the Support Hanger Bracket. 

Note: Providing enough slack in the Vented Cable at surface allows you to lift the AquaVent Wellhead from the well cap base to 
access the Vented Cable connection, or record manual depth to water measurements, without disturbing the AquaVent 5 logger 
from its down hole position.

Note: The holes in the bracket can accommodate twist ties or zip ties to secure the cable to the bracket  if desired. 



Vented Dataloggers User Guide

Page 54

Lower the Support Hanger bracket into the well until it seats on the shoulder in the well cap base. 

Note: There are three holes in the top of the Support Hanger Bracket that can be used to secure it in the well cap base with screws. 

Connect the other end of the Vented Cable to the AquaVent 5 logger. See section 1.5.1 for more details. Lower the Vented Cable with logger down the well.

Note: For diagnostic purposes, you may wish to install the end of the Vented Cable with the serial number, to the Wellhead connection at surface. 
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Carefully push the excess Vented Cable down the well. Twist the Wellhead onto the well cap base until it seats.

Note: Providing enough slack in the Vented Cable at surface allows you to lift the AquaVent Wellhead from the well cap base to 
access the Vented Cable connection, or record manual depth to water measurements, without disturbing the AquaVent 5 logger 
from its down hole position.

Connect the Vented Cable to the Wellhead. See Section 1.5.1 for more details. Take a manual depth to water 
measurement for your records. 

Figure 8-5 Installation using the Support Hanger Bracket
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8.3  Logger Orientation

It is recommended that the LevelVent 5 or AquaVent 5 logger be installed in a 
vertical orientation. However, inclined or horizontal installation is acceptable. 

The pressure sensor measurement line is indicated by the machined line 
around the logger body, just above the pressure access holes (Figure 8-6). 

The pressure transducer is oriented in a plane normal to the long axis of the 
body, and detects pressure directed along the plane of the long axis. In vertical 
orientations, the sensor detects pressure above the pressure transducer line. 
In non-vertical orientations, the pressure zero point is proportional to the 
angle of inclination. Figure 8-6  

Logger Measurement Line

8.4  Logger Installation Depth

Properly estimate the minimum and maximum water levels expected during the monitoring period. As it 
measures height of water above the sensor, the logger needs to be installed so it remains submerged at all 
times. However, the logger should not be installed deep enough to touch the bottom of a well or channel 
(avoid submergence in sediments).  

Maximum submergence depth must also remain within its specified range throughout the monitoring period. 
The pressure transducer can be damaged, if the logger is over-pressurized by submerging it below its intended 
range. LevelVent and AquaVent loggers are warranted up to 200% of their full scale range, however, accuracy 
can not be guaranteed beyond full scale. 

8.5  Installation Precautions 

Carefully lower the logger into water. The impact of suddenly dropping the logger into water could permanently 
damage the transducer. Care should be taken to avoid dropping the logger against a hard surface.   

Other important considerations when installing the logger in pressurized or intermittently pressurized locations 
such as pressure vessels, pressurized pipes, pulse flow conditions, drop structures or near hydraulics works, is 
to keep in mind the potential effect of water or steam hammer and hydraulic jump. 

Water hammer is caused by an abrupt alteration of flow direction resulting in pressure surges. Steam hammer 
occurs when steam enters a cold pipe partially filled with water. The hammer effect has the potential to 
significantly increase hydraulic pressure possibly exposing the pressure sensor to pressures beyond its 
maximum rating.  

Hydraulic jump is a phenomenon that occurs when water is ‘lifted’ or ‘ramped’ by velocity or flow obstructions. 
Hydraulic jump causes turbulence and creates non-representative head conditions in the water column. Care 
should be taken to avoid installation at points susceptible to hydraulic jump.
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8.6  Installation in Extreme Environments

8.6.1  Freezing or High Temperature Conditions

Installation in locations that may be at risk of freezing is not recommended without taking precautions. When 
water freezes it expands approximately 9% by volume. A 9% expansion can equate to extreme pressure. 
Therefore, solid freezing has the potential to damage the pressure transducer, which is rated to withstand up 
to 200% of its depth fluctuation range. As such, care should be taken when choosing the appropriate pressure 
transducer range for your application. 

Note: Although precautions can be taken, placing a LevelVent 5 or AquaVent 5 in a situation where the water may freeze solid can 
permanently damage the sensor.

If monitoring shallow water bodies or groundwater zones susceptible to freezing, the easiest way to avoid 
transducer damage is to lower the transducer to a point in the water column below the frost line or ice 
formation depth. In water bodies such as shallow streams, wetlands or ponds where freezing may penetrate 
to the bottom, install the LevelVent 5 or AquaVent 5 in a vented stilling well imbedded into the bottom of the 
water body beyond the frost line. 

In cases where the above noted precautions cannot be taken and the LevelVent 5 or AquaVent 5 logger must 
be installed in the freezing zone, it is recommended that they be placed inside a thick membrane balloon filled 
with a non-toxic, non- corrosive anti-freeze solution and sealed. Place the balloon in a section of perforated, 
30 mm (1.25") ID pipe and install the logger in the monitored water. The antifreeze solution will protect the 
logger from ice expansion at the pressure transducer, yet transmit any pressure and temperature fluctuations 
that occur. However, it should be noted that even if these precautions are taken, there is still the risk that 
placing a LevelVent or AquaVent in a situation where the water may freeze solid can permanently damage 
the sensor.

Please note that a similar installation protection can be used when the logger is monitoring liquids which are 
incompatible with its wetted materials. 

The operating temperature range for the LevelVent and AquaVent loggers is -20° to 80°C (-4° to 180°F).  
At the opposite end of the thermal scale, exposing to temperatures beyond 80°C may damage the batteries/
electronics and otherwise affect the instruments.

8.6.2  Marine or Brackish Installations

When installing a LevelVent or AquaVent in salt or brackish water or in a liquid having a specific gravity 
(density) different than fresh water, the density difference is compensated for by inputting the density of the 
monitored fluid in the Data Wizard (see Section 6).

The LevelVent 5 or AquaVent 5 can be used for monitoring in salt or brackish water. However, long term use 
of the stainless steel body LevelVent and AquaVent in salt or brackish water is not recommended, as the salt or 
other pollutants may cause pitting which can lead to perforation of the logger’s casing. To minimize this effect, 
regularly lift the logger from the liquid; within seconds a thin protective layer will be formed by oxidation. 

If using a LevelVent or AquaVent in a continuous salt/brackish monitoring scenario, the stainless steel body of 
the logger can be protected in a manner similar to the freezing protection method described in Section 8.6.1. 
The logger can be placed in a thick membrane balloon filled with non-corrosive/ non-toxic fluid, such as tap 
water. As pressure changes, the fluid encasing the logger will transmit the pressure differential to the pressure 
transducer.
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8.6.3  Biofouling Conditions

Biofouling is the unwanted buildup of microorganisms, plants, algae, or 
organisms such as barnacles and muscles on a wetted surface. When a 
LevelVent or AquaVent is deployed for an extended period of time, especially 
in a saltwater environment, there is the risk of biofouling. Biofouling on the 
pressure sensor can compromise the accuracy of the measurements.

A Solinst Biofoul Screen can be used to protect the LevelVent or AquaVent 
from biofouling. The copper-coiled Delrin screen naturally reduces biofouling, 
and lengthens the time a datalogger can be deployed before maintenance is 
required. The Biofoul Screen simply slips onto the sensor end of the logger 
where it is held in place with its compression fitting. It adds about 19 mm (3/4")  
to the length of the logger. It allows water to freely enter the pressure 
transducer inlets. It is replaced as required.

42 mm 
(1.65”) 

105 mm

4–1/8" 

Figure 8-7 Biofoul Screen Dimensions

Figure 8-8 Solinst Biofoul Screen
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9  Vented Datalogger Maintenance

As with any groundwater or surface water monitoring project, you should select the proper equipment and 
determine a maintenance schedule based on the monitoring environment specific to your application.

For the LevelVent and AquaVent, this means selecting the appropriate pressure range, ensuring the monitoring 
temperatures are within the instruments specifications, and making sure the wetted materials are compatible 
with site chemistry.

9.1  Logger Maintenance

Logger maintenance consists of cleaning the outside casing and the circulation holes. The required frequency 
of cleaning is dependent on several aspects of the monitored water quality. In freshwater with good to 
excellent water quality, the cleaning requirements will be very minimal; amounting to a seasonal or even 
annual maintenance inspection. 

In most cases cleaning can be accomplished by rinsing the logger and using mild, non-residual, non-abrasive 
household cleaners with a very soft-plastic, bristled, pipe-cleaner type brush. Do not insert any object through 
the circulation holes at the sensor end of the logger. 

In some cases simple cleaners are insufficient to properly clean the logger.  Several commonly occurring water 
conditions require specific maintenance methods. These include hard water, high suspended solids loading, 
biological or chemical fouling and salt or brackish water conditions. 

Hard water monitoring can result in the precipitation of calcium and magnesium deposits on the  
pressure transducer as well as other components of the logger. These deposits can be safely dissolved using 
a diluted solution (typically ≤ 10% strength) of acetic or phosphoric acid. Commercially available products for 
dissolving hard water scaling are also available and can be used if designed for household use. Some industrial 
strength hard water scaling removers are much higher strength and are not recommended for cleaning the 
logger. 

High suspended solids load may block the circulation ports or clog the internal pressure cell of the logger. 
The potential clogging effect of solids deposition can be minimized by placing the logger in zones of flow.  
To remove solids build up, rinse the logger under a low flow of tap water until particles have been washed away.

Bacteriological or chemical fouling can be an important consideration in many ground and surface water 
monitoring projects. Sessile bacteria will often utilize installed instrumentation as an attachment substrate. 
Chemical deposit can be the result of electrical charge differential between the instrumentation of the monitored 
liquid or the result of biological or algal activity. Both forms of fouling can result in difficult to remove deposits 
on the logger transducer, the conductivity wires and the logger casing. To remove fouling use a diluted  
(≤10%) solution of sulfuric acid.  Persistent material may require soaking for several hours.
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For loggers being used with older style Vented Cables (sold before 4/16/21 with serial numbers lower 
than 506326), replacing the o-ring should be done on a regular basis. The o-ring ensures a tight seal at the 
Vented Cable connection, which is important for keeping moisture out. Replacement o-rings are available in 
sets of ten from Solinst. 

Figure 9-1 O-Ring at the Vented Cable Connection – older style loggers

Proper storage when not in use is important. The logger should be stored with the protective cap threaded 
onto the Vented Cable connector. The hard case that the logger was received in, should also be used to protect 
the logger during storage. 

Figure 9-2 Logger with Storage Cap and Protective Case

9.2  Vented Cable Maintenance

Proper storage of the Vented Cable is very important. The Vented Cables are shipped with the ends capped; 
these caps should be retained, and used to seal the Vented Cable connections when not in use and during 
periods of storage. It is also recommended the Vented Cable be stored on the spool it was received on  
(for longer lengths). This protects the Cable and avoids the vent tube from being kinked. 

Note: Before the Vented Cables are shipped, the vent tubes are blown dry with nitrogen gas, and capped, to ensure no moisture 
during transport. These caps should be retained.

To ensure the vent tube is dry before deployment or storage, Solinst offers a special fitting that allows you to 
blow nitrogen gas through the tube. See Section 9.2.1.

Cleaning the connections ensures a proper seal. A cotton swab can be used to clear any moisture or debris 
from the connectors.

Figure 9-3 Vented Cable Maintenance

Storage 
Cap

O-Ring

Storage 
Spool
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9.2.1 Vented Cable Blowout Fitting

Using the Vented Cable Blowout Fitting to dry the vent tube is recommended before starting any new project 
or before storing the Vented Cable. 

Figure 9-4 Vented Cable Blowout Fitting

To use the Vented Cable Blowout Fitting:

Note: Always follow Personal Protection Protocol when working with a compressed gas.

1. Remove the storage caps from both ends of the Vented Cable (remember to save the caps). Or if deployed,  
 remove the logger and Wellhead. 

2. Connect one end of the Vented Cable to the correct connection on the Blowout Fitting. Ensure proper alignment  
 before pushing the connection together. Twist the coupling onto the Blowout Fitting until it seats. Do not twist  
 the Vented Cable, cable connector body, or Blowout Fitting. 

Note: Do not twist the Blowout Fitting, Vented Cable or cable connector body when connecting to the fitting.  
Only twist the coupling. 

Vented Cable 
Connection

Nitrogen Gas 
Tank Hose Fitting 

Connection

Vented Cable  
 Coupling

Figure 9-5 Vented Cable Connected to the Blowout Fitting

3. Connect the other end of the Blowout Fitting to the  
 nitrogen gas tank hose fitting. 

4. Slowly apply 25-30 psi of nitrogen gas to the Vented  
 Cable. Let pressure flow through the cable for about  
 5 minutes. If you hear no air flow, you can apply up  
 to 50 psi of pressure to clear any blockages. 

Note: Do not exceed 50 psi of pressure when using the  Vented 
Cable Blowout Fitting.

5. Turn off the nitrogen gas flow and remove the Vented  
 Cable from the Blowout Fitting. 

6. If deploying the datalogger immediately connect one  
 end of the Vented Cable to the logger, and the  
 other to the Wellhead. See Section 1.5.1 for  
 connection instructions.  

7. If storing the Vented Cable, immediately install the  
 storage caps to both ends of the Vented Cable. 

Figure 9-6 Nitrogen Gas Being Blown Through  
the Vented Cable

Cable Connector Body

“M” Style Quick-
Connect Nipple
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Dust Cap & O-ring

Dust Cap

9.3  Wellhead Maintenance

Replacing the batteries in an AquaVent Wellhead will have to be done on a regular basis, and is based on 
usage. See Section 8.2.1 for battery life estimates and installation instructions. 

Note: After retrieving the settings in Levelogger Software, If the Wellhead batteries have drained to 20% charge or lower, a 
warning message will appear to replace the batteries. 

For Wellheads being used with older style Vented Cables (sold before 4/16/21 with serial numbers lower 
than 506326), replacing the o-ring at the Vented Cable connector should be done regularly. The o-ring 
ensures a tight seal at the Vented Cable connection which is important for keeping moisture out. Replacement 
o-rings are available in sets of ten from Solinst. 

When not in use, the Wellhead should be stored with the dust cap on the Vented Cable Connector. The blue 
dust caps should also be secured to the cable connector(s) on the side of the AquaVent Wellhead, and the black 
dust cap on the top of the LevelVent Wellhead. 

Figure 9-7 Wellhead O-ring (older style Wellheads) and Dust Cap at the Vented Cable Connections

Dust Cap

O-ring

Top View

Bottom View

Top View Bottom View
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10  Diagnostics Utility

The Levelogger Software Diagnostics Utility can be used for troubleshooting dataloggers and obtaining 
information that can assist the Solinst Technical Support representative to identify and fix any problems you 
may encounter. The Diagnostics Utility can be launched from the Utilities menu at the top of the software. 
The utility can be used to run a self-test, do a Memory Dump, create and email reports, and reset the 
AquaVent battery indicator.

10.1  Run Diagnostics

The Run Diagnostics function reads the following information from the datalogger:
 1) Logger and AquaVent Wellhead Serial Numbers
 2) Logger Model Number
 3) Logger and AquaVent Wellhead Firmware Versions
 4) Battery Voltage
 5) Battery Charge Level
 6) Current Level Reading
 7)  Current Temperature Reading
 8) Max/Min Pressure Reading
 9) Max/Min Temperature Reading
 10) Total Number of Logs

This information can be used to identify firmware, battery and/or temperature/pressure sensor problems. 
This function also performs a series of self-tests on the datalogger to check for problems with the battery, 
memory, pressure/temperature sensor. If any of these tests fail then a report should be created and emailed 
to Solinst Technical Support. To execute this function simply click the ‘Run Diagnostics’ button.

Figure 10-1  Run Diagnostics
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10.2  Read Memory Dump

This function creates a complete dump of the datalogger’s memory, which can then be sent to Solinst Technical 
Support for analyzing, or converted to *.xle files that you can open in the Data Control tab. 

Note: It is recommended that, before attempting to use this function, you use the ‘Create Report’  function to send a report to the 
Solinst Technical Support.

To execute this function simply click the Read Memory Dump button. Performing a memory dump will create 
an *.hex file of the data that is saved on your PC.

Figure 10-2 Read Memory Dump

10.2.1  File Conversion (hex to xle)

This function converts the *.hex file that was created and saved with the Read Memory Dump function, to 
*.xle files that you can open in the Data Control tab, or send to Solinst for technical support. A list of the files 
created will be displayed.

Figure 10-3  Hex To _xle File Conversion List
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Figure 10-4  Customer Info Input Window

Figure 10-5  Report Example

10.4  Email Report

Clicking Email Report will guide you through the process of creating a Diagnostics Report, and it will 
automatically attach the report to an email to send to Solinst Technical Staff for troubleshooting.

10.5  Software/Firmware Updates

Each time the Diagnostic Utility is opened, it automatically checks for software updates. If there is an update, 
"Software Update Available" will appear in the top right of the window. When you click the message, a web 
page will open, allowing you to download the software update.

Note: Your Computer must have an Internet connection to check for software and firmware updates.

Note: You can also check for updates using the Help menu.

The Utility also checks for firmware updates. "Firmware Update Available" will appear in the top right of 
the window. Clicking the message will open a web page where you can download the firmware update. See 
Section 11 for firmware update instructions.

10.3  Create Report

This function simply creates a text file containing the information obtained from the Run Diagnostics 
function. When you click the Create Report button, a window will pop up asking you to fill out your company 
information. Simply fill this out and the resulting report can be saved or sent to Solinst Technical Support for 
troubleshooting.

Note: The ‘Email Report’ option automatically creates a report and attaches it to an email to send to Solinst - all in one step.
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Figure 10-6 Reset AquaVent Battery Indicator

10.7  Clear Datalogger Zero

To clear a previously performed field zero (See Section 4.8), click “Clear Datalogger Zero”. 

10.6  Reset AquaVent Battery Indicator

After replacing the Wellhead batteries, in order to reset the battery indicator in the Levelogger Software, click 
the “Run Diagnostics” button, then click “Reset AquaVent Battery Indicator”. 

Figure 10-7 Clear Datalogger Zero
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11  Firmware Upgrade Utility

With the logger connected to the Wellhead by the Vented Cable, use the USB PC Interface Cable to connect 
the LevelVent Wellhead to the PC, or use the USB Connector Cable to connect the AquaVent Wellhead to 
the PC. 

Note: To check for firmware updates using Levelogger Software, retrieve settings from the connected datalogger (see Section 4). 
“Firmware Update Available” will appear in the top right menu bar if there is an update available. Clicking the message will open a 
web page where you can download the firmware update. You can also use the Software’s Help menu. 

The SPX AquaVent Wellhead also needs a power supply connected to the SDI-12/MODBUS Connector 
Cable in order to perform the firmware upgrade. See separate User Guides for power connection instructions. 

The Firmware Upgrade Utility is used to upload new firmware files to a LevelVent logger, AquaVent 
logger and/or SP/SPX AquaVent Wellhead. The Firmware Upgrade Utility can be launched from the 
Utilities menu at the top of the Levelogger Software. The zipped firmware file can be obtained from:  
https://www.solinst.com/downloads/

Note: While the firmware is being updated, the SPX Wellhead will ignore or provide time-out response to any requests from the 
MODBUS or SDI-12 network. 

Make sure to unzip the firmware file after you have downloaded it, so you can access the *.ssf file. There are 
separate firmware files available; one for the LevelVent logger, one for the AquaVent logger and one for the 
SP/SPX AquaVent Wellheads. Update each hardware component separately; update the AquaVent Wellhead 
before updating the AquaVent logger. 

Note: It is important that the communication between the PC and the datalogger is not interrupted during a firmware upload, so 
please make sure to close any other running programs, including screen savers, and do not disconnect the datalogger before the 
upload is finished.

To upload new firmware to a logger or AquaVent Wellhead, follow these steps:

Figure 11-1 Firmware Upgrade Utility Window

1)  Open the Solinst Firmware Upgrade Utility from the Utilities menu  
 in the Main Levelogger Software Window.  

2)  Click the ‘Open’ button , which should open a file dialog asking  
 for the firmware file (*.ssf) to upload.  Navigate to the directory  
 where the firmware file was saved on your PC, then click on the file  
 and click ‘Open’.

3)  Check the ‘File Information’ box to make sure the opened file is  
 correct.

4)  Click the ‘Upload Firmware’ button , to start the firmware  
 upload process. 

Note: If an upgrade process in the SPX Wellhead fails or is interrupted, then 
recovery may require a power cycle, usually accomplished by unplugging 
the USB Connector Cable and SDI-12/MODBUS Connector Cable, then re-
connecting after 30 seconds. 

5) If a communication error occurs and is indicated in the ‘Datalogger  
 Status’ box either before or after the “Verifying Firmware” and   
 “Loading Firmware to Datalogger” messages, then restart the  
 upgrade process.

6) If, however, a communication error occurs between the “Verifying  
 Firmware” and the “Loading Firmware to Datalogger” messages,  
 then please contact Solinst. You will need to give the datalogger  
 Serial Number and explain the exact positioning of the error  
 message.
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12  Troubleshooting

12.1  Problems During Installation of Levelogger Software

‘Class not Registered’ or ‘DLL not found’ or ‘Access violation’ 

1) You may not have Administrator Rights to install the software in the Windows 10 environment. 

  - Ask your System Administrator for assistance. 

2) Some files got corrupted during installation of the Levelogger Software. Use ‘Add/Remove Programs’ to  
 uninstall, and then install a new current copy of the latest Levelogger Software from:  
 https://www.solinst.com/downloads/

12.2  Error During Software Uninstall Process

The ‘Add/Remove Program’ cannot locate the Levelogger <setup.exe> file of the software or the link between 
the software and the ‘Add/Remove Program’ is damaged.

The record in the Registry Table must be removed: 

1)  Ask your System Administrator to remove this.

2) Refer to the following link from Microsoft Website for instructions: 
 http://support.microsoft.com/default.aspx?scid=kb;en-us;247501

12.3  Data Has Been Erased Accidentally

If a previous version LevelVent or AquaVent datalogger has been restarted and old data has not been saved, 
go to Download Options and choose Data Recovery. It downloads the immediately previous log. 

12.4  Error Messages During Use of Software

‘Communication Time Out’ or ‘Communication Error’ or  
‘The Command that is sent to the Levelogger is not defined’

1)  Try communicating with another logger, Wellhead, Vented Cable or USB  PC Interface/Connector Cable.

2)  Clean the Vented Cable connections to the logger and Wellhead.

3) Check that the USB PC Interface/Connector Cable is connected to the same Com Port that is chosen in the  
 upper middle of the Main Window of the Levelogger Software.

4) Check the Com Port settings. They should be as follows:

• Bits per second: 9600
• Data bits: 8
• Parity: None
• Stop bits: 1
• Flow control: None  
 (This may have been set to Xon/Xoff – change it to None, Select [OK]   
 and back out of this pathway.)
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The route to view your Com Port settings is as follows:

a. Select Control Panels
b. Double click on System
c. Select the Device Manager Tab
d. Double click on Ports
e. Double click on Communications Port(s)
f. Choose the Port Settings Tab

5)  Try using a different computer, to see if this is the cause of the problem.

6)   If problem persists, contact Solinst.

'Port Cannot Open’

1)  Ensure you have plugged the USB PC Interface/Connector Cable into the PC before starting Levelogger  
 Software.

2) Ensure the correct Com Port is selected in the upper middle of the Main Window of the Levelogger Software.

3) Check if some other software is using the same Com Port in the background. Shut that software down or  
 choose another Com Port if available. Such background software may be anti-virus software or PDA software.

4) Make sure your Com Port has been enabled: 

a. Select Control Panel
b. Double click on System
c. Select the Device Manager Tab
d. Double click on Ports
e. Double click on Communications Port(s)
f. Choose General 
g. Uncheck ‘Disable in this hardware profile box’

‘File Create Error’ and ‘File Write Error’

1)  If you do not have file-writing privileges to the default data folder, change the folder as follows: in the Levelogger  
 Software, click ‘Configuration’ then ‘Application Settings’. Under ‘Default Directory’, enter a new destination  
 folder, to which you have file writing privileges, e.g. ‘My Documents’. Follow the same procedure if you have  
 the same problem when you export the data file in csv format. 

2) Ask your System Administrator for assistance.

‘File Open Error’ and ‘File Read Error’

1) Shut down or disable any other software that is active and using the same file.

2) In Notepad or Wordpad, open the <*.xle> file to check for corruptions. How are the data files ended?

3) If problems persist contact Solinst for assistance.

‘A different type of Levelogger is detected’

Try clicking the Retrieve Settings icon again, or replace the datalogger currently connected, with the one that 
was previously being worked on, and complete the operation. 

‘Data Corrupted’

Contact Solinst for assistance. Use the Diagnostic Utility to do a memory dump and sent the dump file to 
Solinst for further analysis.
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‘Internal Error’

Contact Solinst for assistance.

‘Fail to append data - A different Levelogger has been detected!’ or ‘Fail to append data - A different 
start time has been detected!’ or ‘Fail to append data - New data is not available in the Levelogger!’ 

The Levelogger Software can only append data to a file that has the same serial number and start time as the 
connected datalogger.  Find the correct file, or use ‘All Data’ to download the complete file.

‘Only Levelogger Gold/Edge/5 supports this function’

The ‘Append Data’, ‘Partial Download’ and ‘Data Recovery’ functions are only supported by the Levelogger 
Gold/Edge/5/LevelVent/AquaVent.

‘Schedule cannot be empty’

When using the ‘Schedule’ sampling option for a datalogger, the schedule must contain at least one item.

‘Readings in schedule exceed the maximum’

The number of readings in a schedule should not result in more than 150,000 individual readings.
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